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About This Guide

This GroupWise 2014 Interoperability Guide helps you use GroupWise in the context of other 
software products.

For information about additional GroupWise-related software from GroupWise partners, see the Micro 
Focus Partner Product Guide (http://www.novell.com/partnerguide/).

The following resources provide additional information about using GroupWise 2014:

 Micro Focus Support and Knowledgebase (http://www.novell.com/support/)

To search the GroupWise documentation from the Micro Focus Support website, click Advanced 
Search, select Documentation in the Search In drop-down list, select GroupWise in the 
Products drop-down list, type the search string, then click Search.

 GroupWise Support Forums (https://forums.novell.com/forumdisplay.php/356-GroupWise)
 GroupWise Support Community (http://www.novell.com/support/kb/product.php?id=GroupWise)
 GroupWise Cool Solutions (https://www.novell.com/communities/coolsolutions/category/

groupwise/)

Audience
This guide is intended for network administrators who install and administer GroupWise. 

Feedback
We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation.

Additional Documentation
For additional GroupWise documentation, see the Micro Focus GroupWise 2014 Documentation 
website (http://www.novell.com/documentation/groupwise2014/).
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I IClustering

 Chapter 1, “Using Micro Focus Cluster Services with GroupWise 2014,” on page 9
 Chapter 2, “Using Windows Server Failover Clustering with GroupWise 2014,” on page 19
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1 1Using Micro Focus Cluster Services with 
GroupWise 2014

 “Creating a New GroupWise System to Work with Micro Focus Cluster Services” on page 9
 “Upgrading a Clustered Linux GroupWise System to GroupWise 2014” on page 13

Creating a New GroupWise System to Work with 
Micro Focus Cluster Services

For detailed instructions on configuring GroupWise to work with Micro Focus Cluster Services, see 
“Novell Cluster Services on Linux” in the GroupWise 2012 Interoperability Guide. The procedure for 
installing GroupWise 2014 differs from the GroupWise 2014 procedure in the following ways:

 “GroupWise 2014 Installation Wizard” on page 9
 “GroupWise 2014 Admin Console” on page 9
 “GroupWise 2014 Admin Service” on page 10
 “GroupWise 2014 Installation Console” on page 10
 “GroupWise 2014 Load and Unload Scripts” on page 11
 “GroupWise 2014 Cluster Test” on page 12

GroupWise 2014 Installation Wizard
The GroupWise 2014 Installation Wizard is completely different from the GroupWise 2014 Installation 
program. Therefore, the specific installation instructions in “Setting Up a New GroupWise System in a 
Linux Cluster” in the GroupWise 2012 Interoperability Guide no longer apply. There is no longer a 
Configure GroupWise for Clustering option for taking care of certain clustering configuration tasks. 
Those tasks are taken care of in other ways in GroupWise 2014. 

1 Install the GroupWise Server component on each cluster node where a GroupWise agent will 
run for a domain or a post office.
Follow the instructions in Step 1 through Step 9 in “Linux: Installing the GroupWise Server 
Software” in the GroupWise 2014 R2 Installation Guide.

IMPORTANT: Install the GroupWise Server component on all cluster nodes before setting up 
any domains or post offices. Do not start the GroupWise Installation Console at the end of the 
installation process.

GroupWise 2014 Admin Console
In GroupWise 2014, the GroupWise Admin console replaces ConsoleOne as the GroupWise 
administration tool. The instructions that include ConsoleOne in the GroupWise 2012 Interoperability 
Guide can easily be adapted to apply to the GroupWise Admin console in GroupWise 2014. For more 
Using Micro Focus Cluster Services with GroupWise 2014 9
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information, see “Working with the GroupWise Administration Console” in GroupWise 2014 R2 
Installation Guide and “GroupWise Administration Console” in the GroupWise 2014 R2 Administration 
Guide.

GroupWise 2014 Admin Service
You must configure the GroupWise Admin Service to function in a cluster, so that it keeps track of 
which cluster resources are available to it at each point in time. Configuring the GroupWise Admin 
Service for clustering ensures that files associated with domains and post offices are created on 
cluster volumes, rather than on individual cluster nodes.

On each cluster node:

1 Run the following command to enable the GroupWise Admin Service to run in a clustering 
environment:

gwadminutil config -cluster enable
You should receive the following response:

Cluster: enabled
Default Port: 9710

2 Use the following command to restart the GroupWise Admin Service.

rcgrpwise restart gwadminservice
Your GroupWise system is now ready to function in a cluster.

GroupWise 2014 Installation Console
In the Installation console, when you are creating domains and post offices in a cluster, a few fields 
require cluster-specific information.

 Domain Fields
 Post Office Fields

File Standard Location Clustered location

Domain SSL Certificate, 
MTA SSL Certificate, 
GWIA SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates

 (a peer to the domain folder)

Post Office SSL Certificate, 
POA SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates

 (a peer to the post office folder)

MTA Log Files /var/log/novell/groupwise/
                        domain.mta

/groupwise/agents/logs

 (a peer to the domain folder)

GWIA Log Files /var/log/novell/groupwise/
                       gwia.domain

/groupwise/agents/logs

 (a peer to the domain folder)

POA Log Files /var/log/novell/groupwise/
                   post_office.poa

/groupwise/agents/logs

 (a peer to the post office folder)
10 Using Micro Focus Cluster Services with GroupWise 2014
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Domain Fields
When you follow the instructions in “Creating the Primary Domain” in the GroupWise 2014 R2 
Installation Guide, pay special attention to the following fields:

 In the Host field, specify the secondary IP address of the shared resource where you want to 
create the domain.

 In the Domain Folder field, specify a folder on the shared resource where you want to create the 
domain.

Post Office Fields
When you follow the instructions in Step 2 through Step 8 in “Adding a Post Office” in the GroupWise 
2014 R2 Installation Guide, pay special attention to the following fields:

 In the Owning Domain Host field, specify the secondary IP address of the shared resource 
where the owning domain is located.

 In the Owning Domain Admin Port field, specify the port on the shared resource for the domain.
 In the Host field, specify the secondary IP address of the shared resource where you want to 

create the post office.
 In the Post Office Folder field, specify a folder on the shared resource where you want to create 

the post office.

GroupWise 2014 Load and Unload Scripts
The sample load and unload scripts that are provided in the following sections of “Novell Cluster 
Services on Linux” in the GroupWise 2012 Interoperability Guide should not be used with GroupWise 
2014:

 “Configuring GroupWise Cluster Resources to Load and Unload the Linux Agents”
 “Configuring the Linux GWIA Cluster Resource to Load and Unload the GWIA and Its MTA”

Use the following scripts instead:

 Sample Cluster Load Script
 Sample Cluster Unload Script

Sample Cluster Load Script
This sample cluster load script performs the following actions:

 Establishes what to do for certain error conditions.
 Creates the GroupWise agent services (if they do not already exist).
 Starts the GroupWise Admin Service listeners with clustering enabled for the MTA and POA.
 Starts the POA, MTA, and GWIA (in that order if all are present)

#!/bin/bash
./opt/novell/ncs/lib/ncsfuncs
exit_on_error nss /poolact=DOM
exit_on_error ncpcon mount DOM=254
exit_on_error add_secondary_ipaddress 151.155.136.248
exit_on_error ncpcon bind --ncpservername=DOM --ipaddress=151.155.136.248
exit_on_error novcifs --add '--vserver=".cn=DOM.ou=servers.o=novell.t=GW14-TREE."'
                      --ip-addr=151.155.136.248
Using Micro Focus Cluster Services with GroupWise 2014 11
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# Start gwadmin service
exit_on_error /etc/init.d/grpwise start gwadminservice

#create agent services
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 
                                                -i /media/nss/DOM/utah
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 
                                               -i /media/nss/DOM/utah/wpgate/gwia
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 
                                               -i /media/nss/DOM/provo
#start admin service listeners
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start utah cluster
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start provo.utah cluster
#start GroupWise agents
exit_on_error /etc/init.d/grpwise start utah
exit_on_error /etc/init.d/grpwise start gwia.utah
exit_on_error /etc/init.d/grpwise start provo.utah

exit 0

Sample Cluster Unload Script
This sample cluster unload script performs the following actions:

 Stops the GroupWise Admin Service listeners for the MTA and POA
 Stops the MTA, GWIA, and POA (in that order if all are present)
 Lists error conditions that can be ignored

#!/bin/bash
. /opt/novell/ncs/lib/ncsfuncs

# Stop admin service listeners
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop utah
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop provo.utah
# Stop GroupWise agents
ignore_error /etc/init.d/grpwise stop utah
ignore_error /etc/init.d/grpwise stop gwia.utah
ignore_error /etc/init.d/grpwise stop provo.utah
ignore_error novcifs 
             --remove '--vserver=".cn=DOM.ou=servers.o=novell.t=GW14-TREE."' 
             --ip-addr=151.155.136.248
ignore_error ncpcon unbind --ncpservername=DOM --ipaddress=151.155.136.248
ignore_error del_secondary_ipaddress 151.155.136.248
ignore_error nss /pooldeact=DOM

exit 0

GroupWise 2014 Cluster Test
Follow the instructions in “Testing Your Clustered GroupWise System on Linux” to verify that the 
GroupWise Admin console keeps track of the cluster resources that are currently available to it.
12 Using Micro Focus Cluster Services with GroupWise 2014
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Upgrading a Clustered Linux GroupWise System to 
GroupWise 2014

 “Installing the GroupWise 2014 Software” on page 13
 “Configuring the GroupWise Admin Service to Function in a Cluster” on page 14
 “Upgrading Domains and Post Offices” on page 14
 “Finishing the GroupWise Software Upgrade” on page 15
 “Providing New Load and Unload Scripts” on page 15
 “Testing the Upgraded Cluster” on page 17

Installing the GroupWise 2014 Software
As with any upgrade, you must upgrade the primary domain first.

1 Stop all GroupWise agents that are running on the node that you want to upgrade first.
2 Install the GroupWise Server component on the first node.

Follow the instructions in Step 1 through Step 9 in “Linux: Installing the GroupWise Server 
Software” in the GroupWise 2014 R2 Installation Guide.

IMPORTANT: Do not start the GroupWise Admin console after installing the GroupWise 
software.

3 Continue with Configuring the GroupWise Admin Service to Function in a Cluster.
Using Micro Focus Cluster Services with GroupWise 2014 13
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Configuring the GroupWise Admin Service to Function in a 
Cluster
You must configure the GroupWise Admin Service to function in a cluster, so that it keeps track of 
which cluster resources are available to it at each point in time. Configuring the GroupWise Admin 
Service for clustering ensures that files associated with domains and post offices are created on 
cluster volumes, rather than on individual cluster nodes.

1 Run the following command to enable the GroupWise Admin Service to run in a clustering 
environment:

gwadminutil config -cluster enable
You should receive the following response:

Cluster: enabled
Default Port: 9710

2 Use the following command to restart the GroupWise Admin Service.

rcgrpwise restart gwadminservice
Your GroupWise system is now ready to function in a cluster.

3 For convenience, configure the GroupWise Installation console to use an authentication mode of 
a user name and password, rather than the default token-based authentication mode:

gwadminutil installcfg -m user -u user_name -p password

4 Continue with Upgrading Domains and Post Offices.

Upgrading Domains and Post Offices
For background information about upgrading your GroupWise system, see “GroupWise System 
Upgrade” in the GroupWise 2014 R2 Installation Guide.

1 In a web browser, start the GroupWise Installation console:

https://domain_server_secondary_ip_address:9710/gwadmin-console/install

File Standard Location Clustered location

Domain SSL Certificate, 
MTA SSL Certificate, 
GWIA SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates

(a peer to the domain folder)

Post Office SSL Certificate, 
POA SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates

(a peer to the post office folder)

MTA Log Files /var/log/novell/groupwise/
domain.mta

/groupwise/agents/logs

(a peer to the domain folder)

GWIA Log Files /var/log/novell/groupwise/
gwia.domain

/groupwise/agents/logs

(a peer to the domain folder)

POA Log Files /var/log/novell/groupwise/
post_office.poa

/groupwise/agents/logs

(a peer to the post office folder)
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2 Provide the user name as password that you established in Step 3 in “Configuring the 
GroupWise Admin Service to Function in a Cluster” on page 14.

3 In the GroupWise Installation console, click Upgrade an Existing Domain or Post Office 
GroupWise 2014.
The Installation console provides a list of agents on the current node. The list is built from the 
gwha.conf file.

4 (Conditional) If there are any domains or post offices that are not currently online to this node, 
select them, then click Remove to remove them from the list.

5 For each domain and post office, verify that the IP address in the list is the secondary IP address 
of the cluster resource.

6 For each domain and post office, verify that there are no port conflicts for the Admin port.
7 (Conditional) If you need to change the IP address or Admin port for a domain or post office, click 

the name of the domain or post office, update the information, then click OK.
8 Click Next to continue with the upgrade.
9 On the Credentials page:

9a (Conditional) If the primary domain is being upgraded, specify the user name for the 
GroupWise Super Admin, and type the password twice for confirmation.
or
Specify the IP address, Admin port, and Admin credentials of the owning domain.

10  Click Next to display the Summary page.
11 Review the summary, then click Finish.
12 Continue with Finishing the GroupWise Software Upgrade.

Finishing the GroupWise Software Upgrade
1 On each cluster node, repeat the steps in the following sections:

 “Installing the GroupWise 2014 Software” on page 13
 “Configuring the GroupWise Admin Service to Function in a Cluster” on page 14
 “Upgrading Domains and Post Offices” on page 14

Remember that you cannot upgrade a post office until its owning domain as been upgraded.
2 Continue with Providing New Load and Unload Scripts.

Providing New Load and Unload Scripts
1 In iManager, replace the existing load script for each cluster resource with a new load script that 

is similar to the following example:

#!/bin/bash
./opt/novell/ncs/lib/ncsfuncs
exit_on_error nss /poolact=DOM
exit_on_error ncpcon mount DOM=254
exit_on_error add_secondary_ipaddress 151.155.136.248
exit_on_error ncpcon bind --ncpservername=DOM --ipaddress=151.155.136.248
exit_on_error novcifs --add '--vserver=".cn=DOM.ou=servers.o=novell.t=GW14-
TREE."'

--ip-addr=151.155.136.248
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# Start gwadmin service
exit_on_error /etc/init.d/grpwise start gwadminservice

#create agent services
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah/wpgate/
gwia
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/provo
#start admin service listeners
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start utah cluster
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start provo.utah cluster
#start GroupWise agents
exit_on_error /etc/init.d/grpwise start utah
exit_on_error /etc/init.d/grpwise start gwia.utah
exit_on_error /etc/init.d/grpwise start provo.utah

exit 0
This sample cluster load script performs the following actions:
 Establishes what to do for certain error conditions.
 Creates the GroupWise agent services (if they do not already exist).
 Starts the GroupWise Admin Service listeners with clustering enabled for the MTA and 

POA.
 Starts the POA, MTA, and GWIA (in that order if all are present)

2 Replace the existing unload script for each cluster resource with a new unload script that is 
similar to the following example:

#!/bin/bash
. /opt/novell/ncs/lib/ncsfuncs

# Stop admin service listeners
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop utah
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop provo.utah
# Stop GroupWise agents
ignore_error /etc/init.d/grpwise stop utah
ignore_error /etc/init.d/grpwise stop gwia.utah
ignore_error /etc/init.d/grpwise stop provo.utah
ignore_error novcifs 

--remove '--vserver=".cn=DOM.ou=servers.o=novell.t=GW14-TREE."' 
--ip-addr=151.155.136.248

ignore_error ncpcon unbind --ncpservername=DOM --ipaddress=151.155.136.248
ignore_error del_secondary_ipaddress 151.155.136.248
ignore_error nss /pooldeact=DOM

exit 0
This sample cluster unload script performs the following actions:
 Stops the GroupWise Admin Service listeners for the MTA and POA
 Stops the MTA, GWIA, and POA (in that order if all are present)
 Lists error conditions that can be ignored
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NOTE: The pkill command used in earlier versions of the GroupWise unload script is no longer 
needed. In GroupWise 2014, the grpwise script terminates GroupWise agent processes 
according to the wait setting specified in the gwha.conf file. The default is 60 seconds. If that 
amount of time is not sufficient to ensure a clean shutdown of the agents in your GroupWise 
system, increase the wait setting as needed.

3 Continue with Testing the Upgraded Cluster.

Testing the Upgraded Cluster
1 Follow the instructions in “Testing Your Clustered GroupWise System on Linux” to verify that the 

GroupWise Admin console keeps track of the cluster resources that are currently available to it.
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2 2Using Windows Server Failover 
Clustering with GroupWise 2014

Windows Server 2012 Failover Clustering and Windows Server 2008 Failover Clustering are very 
similar in regards to how GroupWise 2014 interacts with them. In Windows Server 2012 Failover 
Clustering, the term “Cluster Role” replaces the term “Cluster Resource” as used in Windows Server 
2008 Failover Clustering. The example in this section uses Windows Server 2012 functionality and 
terminology.

 “Creating a New GroupWise 2014 System in a Windows Failover Cluster” on page 19
 “Upgrading a Clustered Windows GroupWise System to GroupWise 2014” on page 27

Creating a New GroupWise 2014 System in a 
Windows Failover Cluster

The following sections assume a working knowledge of Windows Server Failover Clustering.

 “Preparing to Install GroupWise in the Cluster” on page 19
 “Installing the GroupWise Software” on page 20
 “Configuring the GroupWise Admin Service for Clustering” on page 21
 “Creating the Primary Domain” on page 21
 “Creating a Post Office” on page 22
 “Creating a Script to Start and Stop the GroupWise Agents” on page 24
 “Adding the Script to the Cluster Role” on page 24
 “Testing the Cluster Role” on page 26
 “Clustering the DVA” on page 26

Preparing to Install GroupWise in the Cluster
1 Define at least one Cluster Role.

For a very simple GroupWise system with a primary domain and one post office, you could 
handle the domain and the post office as a single Cluster Role. For a typical GroupWise system 
with multiple domains and post offices, you might to have a Cluster Role for each domain and 
post office.

2 Configure each Cluster Role with the type of File Server.
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3 Configure each File Server Cluster Role with a shared cluster disk and an IP address.
The following example shows two Cluster Roles, ProvoServer and UtahServer.

4 Continue with Installing the GroupWise Software.

Installing the GroupWise Software
1 Install the GroupWise Server component on each cluster node where a GroupWise agent will 

run for a domain or a post office.
Follow the instructions in Step 1 through Step 9 in “Windows: Installing the GroupWise Server 
Software” in the GroupWise 2014 R2 Installation Guide.

IMPORTANT: Install the GroupWise Server component on all cluster nodes before setting up 
any domains or post offices.

2 Continue with Configuring the GroupWise Admin Service for Clustering.
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Configuring the GroupWise Admin Service for Clustering
Configuring the GroupWise Admin Service for clustering ensures that files associated with domains 
and post offices are created on cluster volumes, rather than on individual cluster nodes.

1 Run the following command to enable the GroupWise Admin Service to run in a clustering 
environment:

gwadminutil config -cluster enable
You should receive the following response:

Cluster: enabled
Default Port: 9710

2 Restart the GroupWise Admin Service.
Use the Windows Services administrative tool.
or
Use the following commands at the Windows command prompt:

sc stop gwadmin
sc start gwadmin

3 Continue with Creating the Primary Domain.

Creating the Primary Domain
1 Ensure that the primary domain Cluster Role is online on the cluster node where you want to 

create the primary domain. 
2 Use the GroupWise Install icon on the Windows desktop to access the GroupWise Installation 

console.
3 (Conditional) If you receive a certificate error, continue past it.

File Standard Location Clustered location

Domain SSL Certificate, 
MTA SSL Certificate, 
GWIA SSL Certificate

c:\Program Files\Novell\
   GroupWise Server\
   certificates

\groupwise\certificates

 (a peer to the domain folder)

Post Office SSL Certificate, 
POA SSL Certificate

c:\Program Files\Novell\
   GroupWise Server\
   certificates

\groupwise\certificates

 (a peer to the post office folder)

MTA Log Files \domain_folder\mslocal \groupwise\agents\logs

 (a peer to the domain folder)

GWIA Log Files \domain_folder\wpgate\000.prc \groupwise\agents\logs

 (a peer to the domain folder)

POA Log Files \post_office_folder\wpcsout\ofs \groupwise\agents\logs

 (a peer to the post office folder)
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4 Follow the instructions in “Creating the Primary Domain” in the GroupWise 2014 R2 Installation 
Guide.
Pay special attention to the Host and Domain Folder fields on the System Settings page.

 In the Host field, specify the IP address of the domain Cluster Role.
 In the Domain Folder field, specify a folder on the domain Cluster Role volume.

The clustering example used in this section sets up a GWIA in the primary domain but does 
not create any post offices on the primary domain server. The post office will be created 
later on a different Cluster Role.

5 Continue following the standard instructions to finish creating the primary domain.

NOTE: After you create the primary domain on its Cluster Role, the GroupWise Install and 
GroupWise Administration desktop icons no longer work. The Admin Service is now listening on 
the IP address of the primary domain Cluster Role, not the IP address of the physical node.

6 (Optional) Create new desktop shortcuts for the Installation console and the Administration 
console that use the proper IP address.

7 Continue with Creating a Post Office.

Creating a Post Office
Although you can create a post office on the same Cluster Role with a domain, it is not typical to do 
so. In this example, the post office is created on a separate Cluster Role.

1 Online the post office Cluster Role to a cluster node.
2 Use the GroupWise Install icon on the Windows desktop to access the GroupWise Installation 

console.
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3 Follow the instructions in Step 2 through Step 8 in “Adding a Post Office” in the GroupWise 2014 
R2 Installation Guide.
As with the domain creation process, pay special attention to specific fields.
3a On the System Settings page:

 In the Owning Domain Host field, specify the IP address of the primary domain Cluster 
Role that you set up in “Creating the Primary Domain” on page 21.

 In the Owning Domain Admin Port field, specify port on the primary domain Cluster 
Role.

3b On the Post Office Settings page:

 In the Host field, specify the IP address of the post office Cluster Role.
 In the Post Office Folder field, specify a folder on the post office Cluster Role volume.

The clustering example used in this section does not set up a DVA with the post office. 
For DVA clustering recommendations, see “Clustering the DVA” on page 26.

4 Continue following the standard instructions to finish creating the post office.

NOTE: As an alternative to creating the post office in the GroupWise Installation console, you 
can create the post office in the GroupWise Admin console. Online the post office Cluster Role to 
the same node where the owning domain Cluster Role is running. Then follow the instructions in 
“Creating a New Post Office on an Existing Domain or Post Office Server” in the GroupWise 
2014 R2 Installation Guide.
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Creating a Script to Start and Stop the GroupWise Agents
When a domain or post office Cluster Role is started, stopped, or moved to a new cluster node, the 
accompanying GroupWise agents must also be started and stopped. The GroupWise Admin Service 
also needs to keep track of when domains and post office are added or removed from its cluster 
node. This is accomplished by adding a Windows cluster Generic Script resource to the domain or 
post office Cluster Role. 

The Generic Script performs the following actions:

 Creates a Windows service for each GroupWise agent if the service does not already exist.
 Starts the GroupWise Admin Service for the domain or post office Cluster Role.
 Starts the MTA, and optionally the GWIA, for a domain Cluster Role.
 Starts the POA for a post office Cluster Role.

The Generic Script must be a Visual Basic script. A template is provided in the following location:

c:\Program Files\Novell\GroupWise Server\
                        agents\data\cluster\groupwise_cluster_template.vbs
The script file provides background information about how to edit the script.

1 Create a folder for the script on each cluster node, such as c:\gwcluster.
2 Copy the template script into the gwcluster folder on each cluster node.
3 Edit the template file for a specific Cluster Role.

For a domain Cluster Role, the script would look similar to the following example, which enables 
the MTA and the GWIA for the Utah domain:

gwAgents.Add "Utah MTA", "M:\Utah"
gwAgents.Add "Utah GWIA", "M:\Utah\wpgate\gwia"
For a post office Cluster Role, the script would look similar to the following example, which 
enables the POA for the Provo post office:

gwAgents.Add "Provo POA", "M:\Provo"
4 Save the edited template file with a descriptive name that associates it with its Cluster Role.
5 Copy the customized script to each cluster node, ensuring that it is in the same location on all 

cluster nodes.
6 Continue with Adding the Script to the Cluster Role.

Adding the Script to the Cluster Role
1 In the Failover Cluster Manager, stop or offline the Cluster Role.
2 Highlight the Cluster Role.
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3 On the Actions menu in the right column, click Add Resource > Generic Script.
4 Select Generic Script as the resource type.

5 Specify the full path to the script.
6 Click Next, then click Finish.

IMPORTANT: If there are any errors in the script, or if the script is not available on all of the 
cluster nodes, the addition of the Generic Script resource fails.

7 Edit the properties of the script to add dependencies, so that the file system and IP address are 
enabled on the Cluster Role before the script is run.

7a Highlight the Generic Script resource, then click Properties on the Script menu on the right.
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7b Click the Dependencies tab.
7c Click Click here to add a dependency, then select the Cluster Disk as the first dependency.
7d Click Click here to add a dependency again, then add the IP address.
7e Click OK to save your changes.

8 Continue with Testing the Cluster Role.

Testing the Cluster Role
1 Bring the Cluster Role online.
2 Move the Cluster Role to a different node.

Clustering the DVA
Complete instructions for clustering the DVA are beyond the scope of this example. The following 
suggestions should help you cluster the DVA:

 Do not install the DVA as part of installing a post office. Instead, install it independently. Use the 
following command on the cluster disk where you want the DVA to run:

gwadminutil services -i -dva 
For more instructions, see the following sections in the GroupWise 2014 R2 Installation Guide:
 “Windows: Installing and Starting a New DVA”
 “Setting Up the DVA”

 Create a script and a Generic Script resource to control the DVA. The line for the DVA would look 
similar to the following example:

gwAgents.Add "GWDVA", "M:\Provo"
For instruction, see:
 “Creating a Script to Start and Stop the GroupWise Agents” on page 24
 “Adding the Script to the Cluster Role” on page 24

 Configure the DVA to function in the cluster. 
This requires editing the DVA startup file. For instructions, see “Configuring DVA Log Settings” in 
the GroupWise 2014 R2 Administration Guide. 
Two aspects of the DVA must to customized:
 Configure the DVA with the IP address of the Cluster Role.
 Configure the DVA to create its log files in the following folder:

\groupwise\agents\logs
If you are setting up the DVA as part a post office Cluster Role, this folder has already been 
created when you configured the GroupWise Admin Service to run for the clustered post 
office. If not, you must manually create this folder. In either case, you must configure the 
DVA to have its log files created in this location. 
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Upgrading a Clustered Windows GroupWise System 
to GroupWise 2014

If your existing GroupWise system is in a cluster, you must change the way it is configured in the 
cluster to enable the GroupWise 2014 domains, post offices, and agents to function in the cluster.

1 Stop the GroupWise agents for the domain or post office.
2 Remove the cluster Resource Group for the domain or post office.
3 Upgrade each domain or post office.

For instructions, see“GroupWise System Upgrade” in the GroupWise 2014 R2 Installation Guide

4 Create a Cluster Role for each domain or post office.
or
Create a Cluster Role for a domain and one or more post offices, as required by the existing 
architecture of your Windows Failover cluster.
For instructions, see “Preparing to Install GroupWise in the Cluster” on page 19.

5 Create a script to control the agents in the Cluster Role.
For instructions, see:
 “Creating a Script to Start and Stop the GroupWise Agents” on page 24
 “Adding the Script to the Cluster Role” on page 24

6 Test the new Cluster Role.
For instructions, see “Testing the Cluster Role” on page 26.

7 (Optional) Cluster the DVAs in your GroupWise system.
For instructions, see “Clustering the DVA” on page 26.
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3 3Messenger

Novell Messenger relies on having GroupWise users defined in NetIQ eDirectory. The association of 
both GroupWise and Messenger users with eDirectory User objects enables the display of 
Messenger presence in the GroupWise client. 

GroupWise 2014 users can be defined in NetIQ eDirectory, in Microsoft Active Directory, or in the 
native GroupWise directory. Customized setup is required when you want Messenger presence to 
display in the GroupWise client, but your GroupWise users are not currently in eDirectory. 

For native GroupWise users, you can directly associate them with new eDirectory objects. 

For GroupWise users that have been imported from an LDAP directory such as Microsoft Active 
Directory, the GroupWise users already have direct associations with an LDAP directory, so they 
cannot also be directly associated with eDirectory. In this case, you still must create eDirectory 
objects for them, but you configure your Messenger system to establish a secondary association 
between GroupWise users and their eDirectory User objects that relies on their email addresses.

 “Verifying a User’s Directory Association” on page 29
 “Associating Native GroupWise Users with eDirectory Objects” on page 30
 “Associating Imported GroupWise Users through Their Email Addresses” on page 32
 “Adding Users to the Messenger Contact List” on page 37

Verifying a User’s Directory Association
1 In the GroupWise Admin console, browse to and click a user.
2 Click the General tab.

When the General tab provides fields for specifying the user’s personal information, it shows that 
the user is a native GroupWise user.

3 To handle a native GroupWise user, skip to “Associating Native GroupWise Users with 
eDirectory Objects” on page 30.
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4 When the General tab lists user information that has been imported from an LDAP directory such 
as Microsoft Active Directory:

Skip to “Associating Imported GroupWise Users through Their Email Addresses” on page 32

Associating Native GroupWise Users with eDirectory 
Objects

For background information about native GroupWise users, see “Manually Creating GroupWise 
Accounts” in the GroupWise 2014 R2 Administration Guide.

For native GroupWise users, you can manually create eDirectory objects for them, so that their 
Messenger presence displays in the GroupWise client.

 “Creating eDirectory Objects for Native GroupWise Users” on page 30
 “Associating the eDirectory User Objects with the Native GroupWise User Objects” on page 31

Creating eDirectory Objects for Native GroupWise Users
1 In the GroupWise Admin console, create or verify the existence of an LDAP Directory object that 

represents eDirectory in your GroupWise system.
For instructions, see “Setting Up an LDAP Directory” in the GroupWise 2014 R2 Administration 
Guide.

2 In ConsoleOne with the Messenger snapin installed, display the properties of the 
DefaultScopeProfile object in your Messenger system.
The DefaultScopeProfile object lists the contexts that Messenger searches for User objects in 
order to provide Messenger functionality to those users.
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3 Make a note of the contexts that are valid for users in your Messenger system.
4 In a valid user context, create eDirectory User objects that correspond to native GroupWise User 

objects.
4a Create the eDirectory User objects with the same names as the GroupWise User objects.
4b Have the GroupWise users set the password on their eDirectory accounts to be same the 

password that they use to log in to Messenger.
5 Continue with Associating the eDirectory User Objects with the Native GroupWise User Objects.

Associating the eDirectory User Objects with the Native 
GroupWise User Objects

1 In the GroupWise Admin console, browse to and click the name of a native GroupWise user.
2 Click More > Associate.

3 Select the LDAP Directory object for eDirectory, select the eDirectory User object, then click OK.
4 Display the User General tab to see the LDAP association.

5 Repeat Step 1 through Step 4 to associate all of the native GroupWise users with their new 
eDirectory User objects.

6 Skip to “Adding Users to the Messenger Contact List” on page 37.
Messenger 31

https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admsysadmconaccess


Associating Imported GroupWise Users through 
Their Email Addresses

For background information about importing GroupWise users, see“Creating GroupWise Accounts by 
Importing Users from an LDAP Directory” in the GroupWise 2014 R2 Administration Guide.

Imported GroupWise users that are already explicitly associated with an LDAP directory other than 
eDirectory, such as Microsoft Active Directory, can be associated with your Messenger system 
through their email addresses. You configure your Messenger system with a Messenger Host for 
each GroupWise Internet domain that appears in GroupWise users’ email addresses. 

 “Verifying Your GroupWise System’s Internet Domains” on page 32
 “Creating eDirectory Objects for the Imported GroupWise Users” on page 33
 “Creating Scope Profiles for GroupWise Internet Domains” on page 33
 “Creating Messenger Hosts for GroupWise Internet Domains” on page 35
 “Updating the Messenger System Host List” on page 36

Verifying Your GroupWise System’s Internet Domains
1 (Conditional) If your GroupWise system uses only one Internet domain, skip to “Creating 

eDirectory Objects for the Imported GroupWise Users” on page 33.
2 In the GroupWise Admin console, click System > Internet Addressing.

3 Make a list of the Internet domain names that your GroupWise users use in their email 
addresses.

4 Continue with Creating eDirectory Objects for the Imported GroupWise Users.
32 Messenger

https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admusernewldapimport
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admusernewldapimport
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#adminfront
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admsysadmconaccess


Creating eDirectory Objects for the Imported GroupWise 
Users

1 In ConsoleOne with the Messenger snapin installed, display the properties of the 
DefaultScopeProfile object in your Messenger system.
The DefaultScopeProfile object lists the contexts that Messenger searches for User objects in 
order to provide Messenger functionality to those users.

2 Make a note of the contexts that are valid for users in your Messenger system.
If your GroupWise system has more than one Internet domain, you need a context for users from 
each GroupWise Internet domain.

3 (Conditional) As needed, create an eDirectory context for each GroupWise Internet domain, and 
add it to the Default Scope Profile.

4 In contexts that correspond to imported users’ GroupWise Internet domains, create eDirectory 
User objects that correspond to imported GroupWise User objects.
4a Create the eDirectory User objects with the same names as the GroupWise User objects.
4b Have the GroupWise users set the password on their eDirectory accounts to be same the 

password that they use to log in to Messenger.
5 Continue with Creating Scope Profiles for GroupWise Internet Domains.

Creating Scope Profiles for GroupWise Internet Domains
The ScopeProfile object for each GroupWise Internet domain lists the eDirectory contexts where 
Messenger searches for User objects for users who have that Internet domain in their email 
addresses.

1 In ConsoleOne with the Messenger snapin installed, browse to and expand the 
MessengerService object.

2 To create a new Scope Profile, right-click the ScopeContainer object, then click New > Object.
3 Select nnmScopeProfile, then click OK.

4 Specify a unique name, then click OK.
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You might want to use a name that is related to the GroupWise Internet domain that you are 
creating the Scope Profile for.

5 (Conditional) If your GroupWise system has more than one Internet domain, repeat Step 2 
through Step 4 to create a Scope Profile for each GroupWise Internet domain.

6 To configure a Scope Profile, right-click the ScopeProfile object, then click Properties.
7 Click Add to add a context to the Scope Profile.

8 Browse to and select a context where you created eDirectory User objects in “Creating 
eDirectory Objects for the Imported GroupWise Users” on page 33.

9 (Optional) Click Include Subcontexts so that Messenger searches the selected context and all of 
its subcontexts for User objects.

10 Click OK to add the context to the list of contexts associated with the Scope Profile.

11 (Conditional) If User objects are located in multiple contexts, repeat Step 7 through Step 10 to 
add each context to the Scope Profile.

12 When you have finished adding contexts, click OK to save the new Scope Profile for the 
GroupWise Internet domain.

13 (Conditional) If your GroupWise system has more than one Internet domain, repeat Step 6 
through Step 12 to configure the Scope Profile for each GroupWise Internet domain.

14 Continue with Creating Messenger Hosts for GroupWise Internet Domains.
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Creating Messenger Hosts for GroupWise Internet Domains
A Messenger Host object links a GroupWise Internet domain (such as example.com) to a Scope 
Profile that provides the contexts where Messenger searches for users that are associated with that 
Internet domain.

1 In ConsoleOne with the Messenger snapin installed, browse to and expand the 
MessengerService object.

2 To create a new Host object, right-click the HostContainer object, then click New > Object.
3 Select nnmHost, then click OK.

4 Specify a unique name, then click OK.
You might want to use a name that is related to the GroupWise Internet domain that you are 
creating the Host object for.

5 (Conditional) If your GroupWise system has more than one Internet domain, repeat Step 2 
through Step 4 to create a Host object for each GroupWise Internet domain.

6 To configure the Host object, right-click the Host object, then click Properties.

7 In the Host Name field, specify the GroupWise Internet domain that the Host object represents, 
such as example.com.

8 In the Scope Profile field, browse to and select the Scope Profile that you created for the 
GroupWise Internet domain in “Creating Scope Profiles for GroupWise Internet Domains” on 
page 33.

9 Click OK to save the Host object.
The Host object links the GroupWise Internet domain to one or more contexts in eDirectory that 
are listed in the Scope Profile.
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10 (Conditional) If your GroupWise system has more than one Internet domain, repeat Step 6 
through Step 9 for each Host object that represents a GroupWise Internet domain.

11 Continue with Updating the Messenger System Host List.

Updating the Messenger System Host List
The Messenger system Host List lists all of the Host objects that Messenger is currently searching for 
Internet domains and Scope Profiles.

1 In ConsoleOne with the Messenger snapin installed, right-click the MessengerService object, 
then click Properties.

2 Click Add to add a Host object to the Host List.
3 Browse to and select a Host object that you created in “Creating Messenger Hosts for 

GroupWise Internet Domains” on page 35, then click OK.
4 (Conditional) If you created more than one Host object in “Creating Messenger Hosts for 

GroupWise Internet Domains” on page 35, repeat Step 2 through Step 3 for each Host object.

5 Click OK to save the Host List.
6 Restart the Messenger agents.
7 Continue with Adding Users to the Messenger Contact List.
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Adding Users to the Messenger Contact List
In order to display Messenger presence in the GroupWise client, you must add the users to your 
Messenger Contact List. Messenger presence in the GroupWise client is displayed only for the users 
in your Messenger Contact List. This is true for all configurations of Messenger, not just when 
associating the eDirectory User objects that are required by Messenger with native and imported 
GroupWise User objects that require no eDirectory objects.

1 In the Messenger client, add all contacts for whom you want Messenger presence displayed.
2 Restart the GroupWise client to establish the associations between the GroupWise client and 

your Messenger contacts.
All users in your Messenger Contact List should now display Messenger presence in the 
GroupWise client.
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4 4Micro Focus Vibe

Before installing Micro Focus Vibe, you should thoroughly review the documentation provided at the 
Micro Focus Vibe documentation website (http://www.novell.com/documentation/vibe34/). These 
guides provide detailed product installation and configuration instructions, but they do not include 
specific instructions for integrating Micro Focus Vibe with GroupWise. This section of the GroupWise 
2014 Interoperability Guide supplies these product-specific instructions.

 “Configuring GroupWise for Use with Micro Focus Vibe” on page 39
 “Accessing Your Vibe Site from the GroupWise Client” on page 41
 “Streamlining Authentication to Vibe” on page 41

Configuring GroupWise for Use with Micro Focus 
Vibe

When you install Micro Focus Vibe with GroupWise, some configuration steps are required to 
integrate the applications.

 “Understanding How Micro Focus Vibe Interacts with an LDAP Directory and GroupWise” on 
page 39

 “Authenticating through the LDAP Directory” on page 40
 “Using GroupWise as the Vibe Email System” on page 40
 “Enabling GroupWise/Vibe Integration for GroupWise Client Users” on page 40

Understanding How Micro Focus Vibe Interacts with an 
LDAP Directory and GroupWise
When you install Micro Focus Vibe in an environment where GroupWise is already set up, the 
products interact in the following ways:

 Vibe can use an LDAP directory (Micro Focus eDirectory or Microsoft Active Directory) to 
authenticate Vibe users. This means that you do not need to create Vibe users manually. Vibe 
can create its user accounts based on the users that already exist in the LDAP directory.

 Vibe can use GroupWise as its integrated email system. This means that email messages sent 
from the Vibe site are delivered to GroupWise mailboxes. It also means that GroupWise users 
can post items to Vibe folders by sending email messages to Vibe folders.

 Vibe information can be displayed in the GroupWise client. Starting in GroupWise 8.0.2, you can 
drag and drop GroupWise items into Vibe folders in the GroupWise Folder List to post items to 
the corresponding folders in your Vibe site. You can also use the GroupWise Find feature to 
search your Vibe site.
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Authenticating through the LDAP Directory
For instructions, see the following sections of the Novell Vibe 3.4 Installation Guide:

 “Gathering Directory Services Information”
 “Adding Users to Your Vibe Site”

Using GroupWise as the Vibe Email System
For setup instructions, see the following sections of the Novell Vibe 3.4 Installation Guide:

 “Gathering Outbound E-Mail Information”
 “Enabling Inbound E-Mail”

See also the following section of the  Novell Vibe 3.4 Administration Guide:

 “Configuring E-Mail Integration”

For basic email usage instructions, see the following sections of the Novell Vibe 3.4 User Guide:

 “Sending E-Mail to Team Members and Announcing the Workspace after Its Creation”
 “Subscribing to E-Mail Notifications from a Folder”, “Setting Up a Folder to Receive Entries Via 

E-Mail” and “Adding Entries to a Folder Via E-Mail”
 “Sending E-Mail from within Vibe”

See also the following sections of the Novell Vibe 3.4 Advanced User Guide:

 “Enabling Folders to Receive Entries through E-Mail” and “Configuring Folders to Send E-Mail 
Notifications to Other Users”

 “Sending E-Mail Notifications”
 “E-Mailing Files and Attachments to the Vibe Site When You Are Over Your Quota”
 “Sending E-Mail”

Enabling GroupWise/Vibe Integration for GroupWise Client 
Users
Before you can integrate GroupWise and Vibe, your Vibe site must be set up, as described in the 
Novell Vibe 3.4 Installation Guide.

1 In the GroupWise Admin console, click Domains, Post Offices, or Users, then click the object 
where you want to make Vibe available to GroupWise client users.

2 Click Client Options > Integrations > Micro Focus VibeS.
3 Select Enable Micro Focus Vibe.
4 Provide the Vibe URL:

4a Use the following format:

https://vibe_server/ssf/ws/TeamingServiceV1
4b (Conditional) If you want to use HTTP instead of HTTPS, include it in the Micro Focus Vibe 

URL field, for example:

http://vibe.yourcompanyname.com
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4c (Conditional) If Vibe is not configured with the default HTTPS port, include the port number 
after the hostname, for example:

vibe.yourcompanyname.com:444
4d (Conditional) If Vibe is not installed in the default location, include the path to 

TeamingServiceV1, for example:

vibe.yourcompanyname.com/Web/Vibe/TeamingServiceV1
5 Click OK.

IMPORTANT: In order for GroupWise users to take advantage of GroupWise/Vibe integration, they 
must provide their GroupWise email address in their Vibe profile.

Accessing Your Vibe Site from the GroupWise Client
Before you can access the Vibe site from the GroupWise client, you must add your GroupWise email 
address to your Vibe profile, as described in “Modifying Your Profile” in the Novell Vibe 3.4 User 
Guide.

The GroupWise and Vibe Quick Start describes the Vibe functionality that becomes available in the 
GroupWise client as a result of the GroupWise/Vibe integration.

Streamlining Authentication to Vibe
You can implement single sign-on for use with Micro Focus Vibe, so that users do not need to log in 
separately to GroupWise and Vibe. See the following sections in “Planning an Advanced Vibe 
Installation” in the Novell Vibe 3.4 Installation Guide:

 “Configuring Single Sign-On with Novell Access Manager”
 “Configuring Single Sign-On with Internet Information Services for Windows”
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5 5Micro Focus Filr

Using Micro Focus Filr with your GroupWise system allows you to store, search, and share 
attachments in Filr. Attachments sent this way take no space in the GroupWise mailbox and are 
automatically shared in Filr. This gives you better control over you attachments and the size of your 
mailboxes.

IMPORTANT: Attachments sent as Filr references are considered an external resource and are not 
part of the message. If you enable Filr, GroupWise attachments stored in Filr are not archived with 
Micro Focus Retain.

Enabling GroupWise for Use with Micro Focus Filr
To enable the Filr integration:

 In the GroupWise Admin console, select the Domain, Post Office, or user where you want the 
Filr integration enabled.

 Go to Client Options > Integrations > Micro Focus Filr and select Enable Micro Focus Filr.

 Enter the URL for your Filr server in the following format:

https://server_ip_or_dns:port

 (Optional) Select Force storage of attachments in Micro Focus Filr and choose Store all 
attachments or Store attachments larger than xx MB.

Using Filr to Manage Attachments
Once Filr is enabled in your system, you can use it to store attachments. Attachments send through 
Filr are stored in a GW Attachments folder. When you send an attachment using Filr, the items are 
automatically shared with the recipients. Use the following methods to manage your GroupWise 
attachments in Filr:

 When adding attachments to an item, select Filr reference in the bottom left corner. You can then 
select a file from Filr to attach to the item.

 When adding an attachment to an item, you can right click on the attachment and select Upload 
to Micro Focus Filr to automatically upload it to Filr.

 If your administrator has forced attachments to be sent through Filr, using a size limit or just 
having all attachments sent through Filr, you receive a warning option upon sending an 
attachment that is not in Filr and the attachment is automatically uploaded to Filr when the item is 
sent.

 Using Find, you can select Micro Focus Filr and the Find searches through your Filr files as well 
as your GroupWise items.

 You can save received attachments to Filr in the File > Save menu.
 To open a Filr reference in an item, right click on the reference and select View in Micro Focus 

Filr.
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6 6De-Mail

De-Mail is an email security system available in Germany. It allows you to securely send confidential 
items electronically.

Enabling GroupWise for Use with De-Mail
To enable the De-Mail integration:

 In the GroupWise Admin console, select the Domain, Post Office, or user where you want the 
De-Mail integration enabled.

 Go to Client Options > Integrations > DE Mail and select Enable DE Mail integration.

 Select if you want to Use Mentana filtering or Use TSystem filtering.

With this enabled, users who send items to a De-Mail address are able to select additional De-Mail 
security options in the item header previous to sending the item.
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7 7GroupWise Identity Manager Driver for 
NetIQ Identity Manager

The GroupWise Identity Manager driver for use with NetIQ Identity Manager provides data integration 
between users in NetIQ eDirectory and GroupWise accounts in your GroupWise system. For 
example, the driver can create email accounts automatically when employees are hired. The driver 
can also disable an email account when a user is no longer active. This configurable solution gives 
you the ability to increase productivity and streamline business processes by integrating GroupWise 
and eDirectory. 

This guide provides information about certain administrative actions in the GroupWise Admin console 
that require you to stop the GroupWise Identity Manager driver or disable a user’s association:

 “Identity Manager Warnings in the GroupWise Admin Console” on page 47

For additional information, see:

 NetIQ Identity Manager (http://www.novell.com/documentation/idm402/)
 Identity Manager Drivers (http://www.netiq.com/documentation/idm402drivers/)

Identity Manager Warnings in the GroupWise Admin 
Console

Some GroupWise administrative actions in the GroupWise Admin console require that you stop the 
GroupWise Identity Manager driver or disable a user’s association with it before you perform the 
action. Most GroupWise administrative actions in the GroupWise Admin console require that you 
manually restart the GroupWise Identity Manager driver or re-enable the user’s association when you 
have completed the action, but a few do not. By default, these activities generate a warning message 
in the GroupWise Admin console:

 “Enabling Identity Manager Warnings” on page 47
 “Associating a GroupWise Object with an eDirectory Object” on page 48
 “Disassociating a GroupWise Object’s Attributes from an eDirectory Object” on page 48
 “Resolving an Invalid Association” on page 48

Enabling Identity Manager Warnings
Identity Manager warnings are disabled by default.

1 In the GroupWise Admin console, click System > System Preferences.
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2 Select Display Identity Manager (DirXML) Warnings, then click OK.

Associating a GroupWise Object with an eDirectory Object
Using the Identity Manager Management role in NetIQ iManager:

1 Stop the GroupWise Identity Manager driver.
2 Establish the association, as described in “Associating GroupWise Users with an LDAP 

Directory” in the GroupWise 2014 R2 Administration Guide.
3 Restart the GroupWise Identity Manager driver.

Disassociating a GroupWise Object’s Attributes from an 
eDirectory Object
In NetIQ iManager:

1 Go to the Identity Manager tab of the User object, then disable the association with the 
GroupWise Identity Manager driver.

2 Disassociate the objects, as described in “Dissociating GroupWise Users from an LDAP 
Directory” in the GroupWise 2014 R2 Administration Guide.

3 Go to the Identity Manager tab of the User object, then enable the association with the 
GroupWise Identity Manager driver.

Resolving an Invalid Association
In NetIQ iManager:

1 Go to the Identity Manager tab of the User object, then disable the association with the 
GroupWise Identity Manager driver.

2 Dissociate the user the reassociate the user, as described in “Directory Associations” in the 
GroupWise 2014 R2 Administration Guide.
48 GroupWise Identity Manager Driver for NetIQ Identity Manager

https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admsystoolsdirassocgwldap
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admsystoolsdirassocgwldap
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#adminfront
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admsystoolsdirassocdisassociate
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admsystoolsdirassocdisassociate
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#adminfront
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#admsystoolsdirectoryassociations
https://www.novell.com/documentation/groupwise2014r2/pdfdoc/gw2014_guide_admin/gw2014_guide_admin.pdf#adminfront


8 8Micro Focus ZENworks

 “Using ZENworks Configuration Management to Distribute the GroupWise Client” on page 49
 “Using ZENworks Application Virtualization for GroupWise and Messenger” on page 51

Using ZENworks Configuration Management to 
Distribute the GroupWise Client

You can use the Configuration Management functionality in Micro Focus ZENworks 11 to distribute 
the GroupWise client to workstations.

 “Prerequisites” on page 49
 “Creating a Bundle for the GroupWise Client Software” on page 50

Prerequisites
Before creating a bundle for the GroupWise client software in Micro Focus ZENworks, you must have 
the following:

 A copy of the following GroupWise client software on the machine where you are creating the 
ZENworks Bundle:
 extract_setupip_packs.cmd
 setupip.fil
 setupip.xx (where xx is a two-letter language code)

The GroupWise client software can be found on the GroupWise server in the following location:

You can also extract the GroupWise Server installation files on your workstation if you don’t have 
access to the GroupWise server. To do this, follow the steps in Extracting the GroupWise 
Software in the GroupWise 2014 R2 Administration Guide.

 A GroupWise MST file to customize the GroupWise install. For information on creating an MST 
file, see Using GroupWise Client Custom Installation Options in the GroupWise 2014 R2 
Administration Guide.

IMPORTANT: If you want a shortcut created on the desktop for GroupWise, make sure that is 
selected in the MST file.

 (Optional) A copy of the GroupWise icon which can be found on your GroupWise server in the 
following location:

\groupwise_software_path\client\win32\groupwise2014.ico

Linux: 
Windows: 

/opt/novell/groupwise/agents/data/client/setup/win32 
c:\Program Files\Novell\GroupWise Server\agents\data\client\setup\win32 
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IMPORTANT: If you don’t want your users to be prompted to install .NET 3.5, you must have it 
installed on the devices previous to installing GroupWise 2014 R2.

Creating a Bundle for the GroupWise Client Software
ZENworks Configuration Management 11 SP4 deploys software as bundles that include all the files 
and instructions required to successfully install software on users’ workstations. To create a 
ZENworks bundle for the GroupWise client software follow the steps below:

IMPORTANT: For background information, or for help completing the ZENworks tasks outlined in the 
steps below, see the ZENworks Configuration Management 11 SP4 documentation at the Micro 
Focus ZENworks Documentation website (http://www.novell.com/documentation/zenworks114/).

1 In the ZENworks Control Center, on the Bundles tab, create a new Window Empty Bundle with 
the following:
 Upload the GroupWise icon as the icon for the bundle. The icon can be found on the 

GroupWise server in the following location:
\groupwise_software_path\client\win32\groupwise2014.ico

 Select Create as Sandbox and make sure Define Additional Properties is selected when 
you finish the bundle.

2 On the Install tab of the bundle, add an Install Files action to copy the GroupWise client install 
files to the workstation. Do the following in the Install Files action:
 Add the following three files:

 extract_setupip_packs.cmd
 setupip.fil
 setupip.xx (where xx is a two-letter language code)

 Select Do not compress or encrypt uploaded content if it is available.
 Set the Destination Directory to a temporary location on the machine where all of the 

GroupWise install actions can be performed. For example:
C:\Windows\Temp\gwclient\

 Make sure Run as secure system user or Run as dynamic administrator is selected for the 
action.

3 On the Install tab of the bundle, add a Run Script action to extract the GroupWise client 
software. Do the following in the Run Script action:
 In the Specify a file on the managed device field, specify the path to the 

extract_setupip_packs.cmd file which was placed on the device in Step 2. For example:
C:\Windows\Temp\gwclient\extract_setupip_packs.cmd

 In the Wait before proceeding to next action box, select When action is complete.
 On the Advanced tab, make sure Run as dynamic administrator or Run as secure system 

user is selected.
When this step runs on the device, a win32 folder is created in the temporary folder where the 
GroupWise client install files were placed previously. You need to know the path to this folder for 
the following steps.
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4 On the Install tab, add an Install File(s) action to copy the GroupWise MST file to the workstation 
to customize the install. Do the following in the Install File(s) action:
 Add the groupwise.mst file.
 Select Do not compress or encrypt uploaded content if it is available.
 Set the Destination Directory to be the path to the win32 folder that gets created by the 

script in Step 3. For example:
C:\Windows\Temp\gwclient\win32

 Make sure Run as secure system user or Run as dynamic administrator is selected.
5 On the Install tab, add a Launch Executable action to install the GroupWise client software on 

the workstation. Do the following in the Launch Executable action:
 In the Command field, specify the path to the install.bat file which is in the win32 folder 

that gets created by the script Step 3. For example:
C:\Windows\Temp\gwclient\win32\install.bat

 In the Command Line Parameters field, specify one of the following:

 Add two Environment Variables:

 If you want GroupWise to be installed for all users on the device, on the Advanced tab 
select Run as dynamic administrator. Otherwise, you can use the default Executable 
security level or Run as logged in user.

The bundle is now configured to install the GroupWise client. Assign the bundle to a test workstation 
to test it and make sure it is working as desired before publishing the bundle.

Using ZENworks Application Virtualization for 
GroupWise and Messenger

Micro Focus ZENworks Application Virtualization lets you convert applications that run on Microsoft 
Windows into self-contained virtual applications. After being virtualized, an application becomes a 
single, isolated file that runs instantly from anywhere, including a thumb drive or other removable 
media. Unlike traditional installation methods, the single virtual application file does not require a 
separate setup process, and does not rely on external components and runtimes, reboots, or 

Parameter Description

/unattended Users see a window showing that GroupWise is 
being installed, but do not have to interact with 
the install.

/silent Users do not see that GroupWise is being 
installed.

Name Value

GW_INST_TRANSFORM_FILE groupwise.mst

GW_INST_REMOVE_MSI True
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administrative privileges. After virtualization, the application is isolated from other system 
applications, preventing DLL conflicts and other deployment nightmares, yet the experience for the 
application’s user is unchanged.

For instructions on virtualizing the GroupWise client, see “Preparing GroupWise and GroupWise 
Notify for Virtualization” in the ZENworks Integration and Streaming Guide (http://www.novell.com/
documentation/zav90/).

For instructions on virtualizing the Messenger client, see “Preparing Novell Messenger for 
Virtualization” in the ZENworks Integration and Streaming Guide (http://www.novell.com/
documentation/zav90/).
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9 9Mobile Devices

The GroupWise Mobility Service provides data synchronization between GroupWise mailboxes and 
mobile devices for synchronizing email, appointments, contacts, tasks, notes, and phone messages. 
The GroupWise Mobility Service is fast, reliable and scalable, and supports the latest device 
operating systems. For more information, see the GroupWise Mobility 2.1 Documentation website.

To support BlackBerry devices with an operating system earlier than BlackBerry 10.x, use BlackBerry 
Enterprise Server for GroupWise.
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